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1. INTRODUCTION TO THE JEROME 651 

 
The Jerome 651 is a non-portable hydrogen sulfide gas monitor designed for perimeter 
and other outdoor locations.  The 651 utilizes a removable 631-X to monitor gas 
concentrations.  The 651 is protected in an insulated all-weather (except flooding) 
enclosure; it is AC powered and has built-in heat and air-conditioning for increased 
631-X accuracy.  The 651 can be remotely polled for up-to-date readings or left 
unattended to log readings for up to a year.  A PC that is equipped with “Jerome Monitor 
Software” (JMS) and a radio modem serves as a Base Station and downloads readings 
from one or multiple 651‟s; the software graphs and reports the data.  The 651 is set up 
at the unit through a menu driven interface and the software can remotely configure the 
sample and sensor regeneration intervals.  The entire system is designed to help 
monitor H2S odor compliance. 
 
This manual contains details that will optimize the results and the life of your Jerome 
651.  Read and refer to the manual for complete details on operation, maintenance and 
troubleshooting. 
 
The Jerome 651 is easy to operate and ready for use upon receipt from the factory.  

 Remove the instrument from the packing material. 

Retain all packaging materials for any future shipment of 
the instrument.  If the instrument is returned to AZI for any 

reason, it must be placed in the original packaging materials 
that have been tested and proven to be effective protection 

during shipment. 

 Call AZI Customer Service at 800-528-7411 or 602-470-1414 for Return Material 
Authorization (RMA) information prior to returning a unit. 

 For all shipments, boxes and packing materials are available from AZI. 

 Pack the Jerome instrument only in a Jerome shipping container. 

AZI WILL NOT BE RESPONSIBLE FOR SHIPPING DAMAGE. 
IF YOU RETURN THE INSTRUMENT IMPROPERLY PACKAGED OR 

SHIPPED, YOU SHOULD INSURE IT FOR FULL VALUE. 

 Check for any damage and confirm receipt of all parts on your packing list.  Contact 
AZI Customer Service at 800-528-7411, 602-470-1414, or through e-mail at 
support@azic.com if you have any questions. 
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2. WARNINGS (READ THIS BEFORE USING THE 651) 

 

 THE 651 IS NOT DESIGNED TO OPERATE IN 
HAZARDOUS LOCATIONS. 

 THE 651 IS DESIGNED FOR ODOR MONITORING 
OF HYDROGEN SULFIDE. 

 
 Read the “631-X Operation Manual” (AZI # 700-0037) for specifics on the 631-X. 

 Sample intervals under 30 minutes will result in a 631-X sensor life of less than 1 
year. 

 Follow local and national codes when installing the 651. 

 It is recommended to use a ground fault circuit interrupter (GFCI) on the AC power 
circuit for safety in an outdoor environment. 

 Do not allow rain to get inside the enclosure. 
 

3. 631-X 

 
 In the 651, the 631-X used has been modified to allow remote control of the keypad.  

A DB9 connector on the back panel allows the 651 to control the 631-X. 

 If the 631-X sample button is pressed, the reading is logged by the 651.   
Do not use any other 631-X button. 

 For maintenance and calibration, the 631-X is easily removed from the 651.  An 
additional 631-X (AZI # X631-0151/-0152) can be purchased to keep the 651 
operating when you send in a 631-X for calibration.   

 To remove the 631-X: 
 Disconnect the AC power for safety.  If the 651 is left on, the “631 System Error” 

occurs on the 651 when a sample is attempted.  To clear the error, reset AC 
power or wait for the 631-X to stop sampling and select the 651‟s 
SYSTEM/RESET menu item. 

 Loosen the 631-X nozzle and pull the elbow fitting out. 
 Disconnect the power and data cables from the 631-X. 
 Use a quick tug to remove the 631-X from the 651. 
 Reverse the procedure to reinstall the 631-X. 

 When replacing the 631-X, the clips that hold the 631-X in the 651 may need 
adjustment.  Loosen the three (3) screws for one of the clips and adjust it, so the 
631-X snaps in place.  If necessary, adjust the second clip as well. 

 When the 631-X is calibrated and installed back into the 651, a new VACUSHIELD 
filter (AZI # 800-0065) must be installed in the 651. 

 The serial number of the new 631-X must be entered into the 651 using the 
SYSTEM/ID/631 SN menu selection at the 651. 

 The 631-X‟s battery pack is internally disconnected to lower heat generation in the 
651.  To use the 631-X outside of the 651, re-connect the battery pack and connect 
the 631-X to AC power to charge the battery pack.  (See the Maintenance Section of 
the 631-X manual) 
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4. SPECIFICATIONS 

 
The heart of the 651 is a Jerome 631-X instrument; refer to the “631-X Operation 
Manual” (AZI # 700-0037) for specifics on the 631-X.  The accuracy and repeatability 
specifications of the 651 are relaxed to take into account the continuous use of the 
631-X sensor. 
 

651 Specifications  

Detectable range 0.003ppm (3ppb) to 50ppm H2S in four graduated 
ranges 

Resolution 0.001, 0.01, 0.1, and 1ppm H2S (four ranges) 

Repeatability 8% relative standard deviation 

Accuracy Range 0:  ± 0.005ppm at 0.050ppm H2S 
Range 1:  ± 0.05ppm at 0.50ppm H2S 
Range 2:  ± 0.5ppm at 5.0ppm H2S 
Range 3:  ± 2ppm at 25ppm H2S 

Estimated sensor life 6 months at 30-minute sample interval and 48-
hour regeneration interval.  3 months at 15-
minute sample interval and 24-hour regeneration 
interval.  The interval could be extended in ideal 
operating conditions. 

Flow rate 150cc/min (0.15 liters/min) 

 User interface 8 digit alphanumeric LCD. 

Menu driven status and configuration. 

Sample interval 1, 2, 5, 10, 15, 30 minutes, 1 and 2 hours 

 

Regeneration interval 6, 12, 24, and 48 hours 

Logging capacity 50,000 readings 

Power requirements 100-120 VAC, 50/60 Hz, 7 Amps or  

210-240 VAC, 50/60Hz, 4 Amps 

Control board fuse Fast Acting IEC 1.6A 250V, 5mm x 20mm  

Operating environment -40° to +55°C (-40°F to +131°F),  

non-explosive, 0 to 100% relative humidity 

Case construction Polyester with insulation to reduce heat transfer 
Weatherproof except flooding 
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Heat and air conditioning Resistive heating and thermoelectric cooling is 
used to maintain the temperature between 20°C 
and 30°C.  Temperature may reach 40°C when 
outside temperature reaches 55°C.   

Dimensions 67 cm wide x 64 cm tall x 23 cm deep 

26” W x 26” H x 9” D 

Weight 24 kg (52 pounds) 

Warranty 1 year, factory parts and labor except for 631-X 
sensor.  See WARRANTY section for sensor 
warranty details. 

 
 

Spectra Radio-Modem Specifications 

Frequency 2.4-2.4835 GHz (2400 MHz), 

49 selectable channels 

Serial Interface RS-232 

Power Requirement 10-30 VDC, 

450 mA 

Operating Temperature -40 to 75 C 

Range Up to 6.4km (4 mile) “line of sight” 

Longer distances may be obtainable through 
use of a high gain antenna or by using the 
Radio Repeater. 
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5. STANDARD EQUIPMENT 

 

 651 (AZI # X651) with door key 

 651 Accessory Kit (AZI # Y990-0194) 

 651 Fixed Point Hydrogen Sulfide Monitor Operation Manual (AZI # 700-0093) 

 Base Station Radio Modem Kit (AZI #Y990-0199)  

 Jerome Monitor Software (JMS) (AZI # 710-0040) 

 631-X Hydrogen Sulfide Analyzer Operation Manual (AZI # 700-0037) 
 

6. OPTIONAL EQUIPMENT 

 
Ammonia Filter Kit (AZI # Y990-0201)   
Chlorine Filter Kit (AZI # Y990-0200)   
Wind Gauge (Anemometer) (AZI # 980-0010) 
651 Wind Gauge Cable (AZI # 200-0137) 
Flow Pump Kit (AZI # Y990-0195)    
Radio Repeater Kit (AZI # Y990-0203) 
Vacushield filter (AZI # 800-0065) 
651 Enclosure Access Hole Grommet (AZI # 350-0128) 
Extra 631-X Hydrogen Sulfide Analyzer (AZI # X631-0151 or X631-0152) 
Grounding Strap (for outdoor antennas) (AZI # 200-0155) 
 
AZI has the standard antenna parts below that can be ordered separately.  These parts 
may be installed at the base station, at the 651, or both.  Using the shortest possible 
cables is recommended to minimize potential signal loss.  For best results, use a cable 
that has less than 11dB/100ft signal loss. 
 
The Spectra radios have an RP-TNC-Jack connector.  The external antennas and 
lightning arrestors have N-Female connectors.   
 
Radio Modem to Lightning Arrestor Cables 

AZI #200-0178 - Cable, RP-TNC-Plug (Radio) to N-Male connector, 5 ft, 2400 MHz 
AZI #200-0177 - Cable, RP-TNC-Plug (Radio) to N-Male connector, 50 ft, 2400 MHz 

 
Lightning Arrestors - AZI #200-0181 - Lightning Arrestor (2400 MHz) 
 
Lightning Arrestor to Antenna Cables 

AZI #200-0180 - Cable, N-Male to N-Male connector, 5 foot  
AZI #200-0179 - Cable, N-Male to N-Male connector, 20 foot 

 
Antennas 

AZI #200-0175 - Std. Phantom Antenna, 2400 MHz (Standard on 651) 
AZI #200-0173 - High Gain Outdoor Antenna, 2400 MHz, 8dB  
AZI #200-0174 - Outdoor Directional Antenna, 2400 MHz 



Page 10 of 80 

 
Antenna Mounting Brackets 

AZI #300-0489 - Antenna Mounting Bracket, Pole Mount 
AZI #300-0490 - Antenna Mounting Bracket, Right Angle Mount To Wall 
AZI #300-0491 - Antenna Mounting Bracket, Straight Mount To Horizontal Surface 

 
Call AZI Customer Service for a part that is not listed.  Antenex is also a good source for 
parts. 
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7. 651 INSTALLATION 

 

Mounting 

 

 Because of the weight of the 651, two people may be required for installation. 

 Wall Mounting: 
Obtain the appropriate anchors from a hardware store for the installation wall type.  Drill 
one of the upper mounting holes into the wall.  Hold the 651 to the wall and mark the 
second upper hole.  Drill the second mounting hole into the wall.  Temporarily mount the 
651 to the wall and mark the lower two holes.  Remove the 651 and drill the lower two 
mounting holes into the wall.  Permanently mount the 651 using all four mounting holes. 

 

Power Connection 

 
POWER CONNECTION NOTES: 
 

 When a generator is used to power the 651, a high-quality line conditioner or voltage 
regulator is required to ensure a pure sine wave and regulated voltage is applied to the 
instrument.  The gold film sensor may be damaged by voltage that varies in amplitude or 
by surges, spikes, and/or noise on the power line. 

 

 Follow appropriate local and national codes when installing the 651. 
 

 It is recommended to use a ground fault circuit interrupter (GFCI) on the 115V or 220V 
AC power circuit for safety in an outdoor environment. 

 

 For fixed-point installations where an FTM (AZI # Z2600 0930 or Z2600 0918) is going to 
be used to verify the operation and compliance of the system, the installation of a 
weatherproof electrical receptacle near the monitoring system is recommended. 

 

 The 651 power voltage is not switch-able in the field.  The 651 is factory 
configured to operate at either 115VAC or 230VAC.  The switch on the 
main circuit board indicates the proper voltage and cannot be changed 
by the user. 
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POWER CONNECTION PROCEDURE:  
 
1. Ensure the facility circuit breaker for the power 

line is open. 
 
 
2. Connect the two power lines and the safety 

ground as shown.  
  
 
3.  Close the circuit breaker and the 651 is powered. 

 At power UP, the display flashes in order: 
 AZI, 
 651 H2S, 
 VX.XX, where X.XX is the version number 

of the 651‟s operating program, and 
 X.XXXPPM, where X.XXX is the detected 

concentration 
of the monitored gas.  

 

Wind Gauge 

 
The optional Wind Gauge can be utilized to track wind speed and direction at sites 
where a weather station or similar system is not available. 
 
INSTALLATION: 

 Confirm that the SYSTEM/WIND/ENABLE menu item is set to YES. 

 Run the “Wind Gauge Cable” into the hole at the bottom of the 651, and seal the 
cable entry with the “Grommet” (AZI # 350-0128).  If desired, cut the excess cable 
and install a new modular jack; ensure that the new jack is put on in the same 
direction. 

 Connect the “Wind Gauge Cable” to the “651 Control Circuit Board” using the “651 
Wind Gauge Cable” (AZI # 200-0137). 

 Install the Davis anemometer according to the Davis installation manual.  When 
attaching the wind vane, use the 651‟s “WIND DIR” status item to view the current 
directional reading.  Refer to the 651 USER INTERFACE section to view status 
items. 

 
SETUP: 

 Using a magnetic compass, select a fixed direction (such as North). 

 Turn the directional potentiometer at the top of the Davis anemometer until the 
display inside the 651 reads the selected fixed direction (e.g. North). 

 Carefully install the directional vane on top of the anemometer and secure by 
tightening the Allen screw. 
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Outdoor/External Antenna Setup 

 
If you have purchased the optional outdoor/external antenna for the 651, the standard 
Phantom antenna mounted in the top of the 651 is unscrewed and replaced with a 
lightning arrestor installed inside of the 651 enclosure.   
 
1. Connect an appropriate cable from the lightning arrestor to the outdoor antenna.  

Refer to OPTIONAL EQUIPMENT for information on the different cables available.  
See the diagram below for an example setup. 
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2. The lightning arrestor must be grounded to provide protection.  Attach the 
grounding strap to the connector of the cable from the lightning arrestor to the 
antenna.  This is just above the lightning arrestor, on the outside of the 651 
enclosure, as shown below.  Use the Grounding Strap to ground the system to a 
metal water pipe running into the ground, grounding spike, or other appropriate 
means using #6 gauge bare copper wire.  (Follow national/local codes).  For 
additional protection, install a lightning rod as well. 

 

 
 
 
 
 
 
 

Lightning Arrestor 

To Antenna 

Connector of Cable 
from Lightning 

Arrestor to Antenna 

Connect #6 Gauge Bare Copper Wire here 

Grounding Strap 
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8. BASE STATION 

 
The radio modem uses a 2.4-2.4835 GHz frequency Spectra radio that may not 
penetrate a building.  To get the best range between the 651 and the Base Station, the 
antennas should have a direct line of sight.  An outside roof mount is desirable for the 
Base Station antenna.  However, for an outside antenna, a lightning arrestor and a 
ground strap are required for safety.   
 
The Spectra 2400 MHz radios have an RP-TNC-Jack connector.  The external antenna 
and lightning arrestor have N-Female connectors.   
 
See OPTIONAL EQUIPMENT on page 9 for a complete list of radio modem 
accessories. 
 

Base Station Setup 

 

 Attach the antenna to the base station 
radio modem as shown.  If an outdoor 
antenna is going to be used instead, see 
the notes at the end of this section.   

 
 
 
 
 
 
 
 
 
 

 
 

 Plug the AC/DC power adapter into a 
local power source and insert the DC 
plug into the radio/modem as shown.  
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 Attach the serial communication cable 
to the radio modem‟s serial port and 
the PC‟s serial port.  The PC‟s COM1 
serial port is typically used unless a 
mouse is using it. 
 

 
 
 
 
 
 
 

 Install Jerome Monitor Software (JMS) to monitor the 651 instrument(s).  See 
JEROME MONITOR SOFTWARE (JMS) INSTALLATION on page 23 for 
instructions. 
 
 

INSTALLATION NOTES: 
 

 If the „line-of-sight‟ is not applicable, the Jerome 651 can run remotely and store up 
to a maximum of 50,000 readings.  

 

 If using a portable laptop PC without a built-in RS-232 serial port, a PCMCIA card 
with an RS-232 serial port may be available for your laptop.   
 AZI recommends the SSP-100 PCMCIA RS-232 card from Quatech.  Visit 

www.quatech.com for more information.  Drivers for the Quatech SSP-100 are 
available on the JMS/651 CD. 

 

 If an outdoor antenna is going to used on the base station:  
 Connect an appropriate cable between the radio modem and the lightning 

arrestor.  Refer to OPTIONAL EQUIPMENT on page 9 for information on the 
different cables available.   

 
 Next, connect an appropriate cable from the lightning arrestor to the outdoor 

antenna.  See the diagram on the next page for an example setup. 
 
 The lightning arrestor must be grounded to provide protection.  Use the 

Grounding Strap to ground the lightning arrestor to a metal water pipe running 
into the ground, grounding spike, or other appropriate means using #6 gauge 
bare copper wire.  (Follow national/local codes).  See the picture on the next 
page for assistance configuring the Grounding Strap. 
 

 For additional protection, install a lightning rod as well to protect the system. 
 
 

http://www.quatech.com/
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Example Base Station with Outdoor Antenna Setup 

Connector of Cable 
from Lightning 

Arrestor to Antenna 

Grounding Strap 

To Antenna 

Lightning 
Arrestor 

Connect #6 Gauge Bare 
Copper Wire here 

Detail of Grounding Strap & Lightning Arrestor 
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9. 651 USER INTERFACE 

 

Status Items: 

 
Normally the instrument displays the H2S gas reading after exiting 
the menu system.  Press [UP] and/or [DOWN] to view the other 
STATUS items: box temperature, time, date, wind direction, wind 
speed, and wind temperature.  When scrolling through the status 
items, a description of the viewed item is displayed for 1 second.  
The description also displays periodically.  The wind items are only 
available if the wind functionality is enabled in the SYSTEM menu. 
 
When a system “ERROR” occurs, it is displayed on the status line and the instrument 
may stop operating depending on the error.  The SYSTEM/RESET menu item can be 
used to reboot the 651, which clears the ERROR.  Wait for the 631-X to stop sampling 
before using SYSTEM/RESET to avoid triggering a 631-X ERROR.  If the error 
condition still exists, the ERROR will occur again.  Contact AZI Customer Service at 
800-528-7411, 602-470-1414, or e-mail at support@azic.com for details and assistance. 
 
 

Selecting Menu Items: 

 
The following key presses are used to navigate the menus and select 
menu items: 

 Press [SELECT] to enter the menus. 

 Press [UP] or [DOWN] to change the selected menu item. 

 Press [SELECT] to pick a submenu, parameter for editing, or 
an action item.  Action items such as “SYSTEM/RESET” require a second press 
of [SELECT] to “CONFIRM?” the action. 

 Press [ESCAPE] to cancel the action or selection. 

 Press [ESCAPE] to exit a menu. 

 

Editing Parameters: 

 
Once a parameter has been selected, the following key presses are 
used to edit the parameter: 

 Press [UP] or [DOWN] to change the alphanumeric digit. 

 Press [SELECT] to move right or save the parameter. 

 Press [ESCAPE] to move left or not save the parameter. 

 

mailto:support@azic.com
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Menu Tree 

 
Use [UP] and [DOWN] to scroll through the STATUS items.  Press SELECT and then 
use [UP] and [DOWN] to access the FTM CHK, SAMPLE, REGEN and SYSTEM 
submenus.  Press SELECT again to make a selection.  The Wind direction, speed and 
temperature status items will not appear If WIND functionality is not enabled in the 
SYSTEM menu. 

 
NOTE: The SYSTEM menu also contains a selection labeled FACTORY.  This option is 
for AZI factory use only and should not be accessed by the end user. 
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 An explanation of the selections available from the menu system is listed in the table 
below. 
 

MENU SUBMENU OPTIONS 

STATUS 
Available 
at turn on 
and 
Escape 

631 RDG Measured gas concentration in PPM 

BOX TEMP Current box temperature 

TIME Current time 

DATE Current date 

WIND DIR Wind direction (if WIND is enabled in SYSTEM menu) 

WIND SPD Wind speed (if WIND is enabled in SYSTEM menu) 

WIND 
TEMP 

Wind temperature (if WIND is enabled in SYSTEM menu) 

FTM CHK  Use for Functional Tests of the instrument‟s response to H2S.  
See OPTIONAL FUNCTIONAL TEST OF 651/631-X, p.22 

SAMPLE INTERVAL Select a sample interval of: 
1, 2, 5, 10, 15, or 30 minutes, or 1 or 2 hours. 

4-20 MAX Set the maximum reading level (in ppm) that will correspond 
to a 20mA current from the 4-20mA connection on the main 
circuit board.  See page 68 for details. 

ALRM LVL 
 

XXX.XXX – Set the signal relay alarm level.  Default is 0 
(Disabled).  See page 68 for details. 

DBL CHK YES, NO – Set the double check high readings. 
Default is YES to repeat reading if a high level is taken.  
Only the second reading is saved. 

VALV TGL Toggle valve.  Default is 0 (No Toggle) 
DO NOT USE THIS MENU ITEM.  AZI USE ONLY. 

REGEN INTERVAL Set the periodic regeneration interval. 
6, 12, 24, 48 hours.  Default is 48 hours. 
An interval less than 48 hours will shorten the life of the gold 
film sensor in the 631-X. 

HOUR ## - Set the hour of the day to initiate the first regeneration.  
Default is 00, midnight. 
EXAMPLE: 

If interval is 12 and hour is 5, the regenerations will be at 
5:00 AM and 5:00 PM. 
If interval is 6 and the hour is 4, the regenerations will be at 
4:00 AM, 10:00 AM, 4:00 PM, and 10:00 PM. 

SYSTEM DATE/TM 
(time) 

Edit the current month, day, year, hour, minute, and second. 
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MENU SUBMENU OPTIONS 

ID Settings used to identify the instrument.   

 INSTRMNT - Contains up to 40 characters that are used to 
identify the instrument or location. 

 631 SN - Contains the serial number of the installed 631-X 
instrument.  Do not edit this value unless swapping 631-X‟s. 

 651 SN - Contains the serial number of the instrument.  Do 
not edit this value. 
 

RADIO ADDRESS:  ##### - The address of the radio modem in this 
651.  Valid input is 0 to 65535.  Default is 0. 

CHANNEL:  ## - Set the radio hopping channel.   
Valid input:  

0 to 48 for Spectra radio modems 
      Default is 4. 
RETRIES:  The number of times the radio will try to send 

information to the base station.   
Valid input is 0 to 9.  Default is 5. 

NET ID: ##### - The radio network ID.  All radios on the same 
network must have the same ID.  Valid input is 0 to 65535.  
Default is 1912. 

POWER: Set the TX (transmission) power level.   
Default is 1W. 

SEC CHNL: ## - Set the 2nd radio hopping channel.  Valid input 
is 0 to 48.  Default is 5.   
Requires Spectra Radio Modem and Radio Repeater Kit 
and Software. 
 

RESET Resets the monitor and clears any errors.  Turn off the 631-X 
before selecting this option. 

 

TEMP C-F Select temperature displayed in either F or C. 

WIND ENABLE:  YES, NO – Enable wind gauge functionality. 
DIR CAL – NOTE: This is not typically used, but can be used 

to get a high degree of accuracy from the wind gauge and 
calibrate the directional potentiometer.  If done incorrectly, it 
could result in significant directional inaccuracy. 

     The maximum resistance is displayed while the user slowly 
rotates the wind vane 2-3 rotations.  The maximum 
resistance is at 355 degrees.  Press [SELECT] to save the 
new calibration. 

TMP FACT – Set the compensation value for the external 
temperature probe for the effects of the internal box 
temperature.  Default is 0.11.   
Do not edit this value. 
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MENU SUBMENU OPTIONS 

FACTORY (Factory use only – DO NOT EDIT OR CHANGE DATA OR 
SETTINGS) 

 
Some of these items are also available for viewing and editing from the computer using 
Jerome Monitor Software (JMS).  During 651 instrument setup, the RADIO ADDRESS 
and CHANNEL must be set at the instrument to enable PC access.  WIND functionality, 
if desired, must be enabled at the instrument as well.   
 
 

10. OPTIONAL FUNCTIONAL TEST OF 651/631-X 

 
AZI has a 30 ppb Hydrogen Sulfide Functional Test Module (FTM), AZI 
P/N Z2600 0930, used to determine if your instrument is functioning 
correctly between recommended factory calibrations.  It allows you to 
have complete confidence in the sample results.  This test verifies 
proper instrument operation through the introduction of a known 
concentration of Hydrogen Sulfide gas.  Call AZI Jerome Sales at (800) 
528-7411 or (602) 470-1414 for availability and pricing. 

 
 

 
THIS VERIFICATION DOES NOT CALIBRATE THE INSTRUMENT. 

 
If your application requires frequent verification of instrument function, this test 
demonstrates the unit‟s operation.  Recording FTM results in an instrument log provides 
a quality control/quality assurance record of instrument function between regular 
calibrations.  If test results fall within the expected range, you may assume the 
instrument is functioning correctly. 
 

Test Procedure 

 
1. Warm up the FTM indoors for six (6) hours to ensure a stable output.  Refer to the 

FTM operation manual, AZI P/N: 700-0095. 
2. After warm up, use a portable power supply to keep the FTM running while checking 

the 651‟s.  (The installation of a weatherproof electrical receptacle near the 
monitoring system is a recommended alternative.) 

3. Open the 651 door, attach the S shaped hanger (AZI # 835-0024) to the 651, hang 
the FTM on the hanger, and attach the FTM sample tube to the 651 intake at the 
bottom. 

4. Press [Select] to enter the menu system; the 651 displays “FTM CHK.” 
5. Press [Select] again; the 651 displays “CONFIRM?” 
6. Press [Select] once more and the 651 will automatically take seven (7) samples. 
7. Average the last (5) samples and the average should be within 26 to 34 ppb. 
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8. Disconnect the FTM from the 651 and reconnect any “bug plugs” or drip controls to 
the intake tube. 

9. Proceed to the next 651 (if applicable). 
10.  The data from (7) FTM samples will be retrieved by the JMS software the next time 

the 651 system is polled.   
 
FTM Check readings will be automatically identified in the “Notes” column in the Data 
screen of the JMS software, so that they are not misinterpreted as regular sample 
readings.  Through the software, the FTM data can also be viewed separately. 
 
 
 

11. JEROME MONITOR SOFTWARE (JMS) INSTALLATION 

 
NOTE: DO NOT LOAD ANY RADIO MODEM SOFTWARE FROM THE RADIO 

MODEM MANUFACTURER ON YOUR PC. 

ONLY LOAD THE JMS SOFTWARE INCLUDED WITH THE 651. 
 

 To install or operate JMS, the user must be an Administrator on the target PC. 
 

 Verify that your system meets the requirements necessary to run JMS: 
o Windows XP with 128 MB RAM (256 MB recommended) 
o 25 MB free space on C: (100 MB recommended) 
o JMS is NOT Windows Vista compatible 

 

 If the setup program does not start automatically upon inserting the CD-ROM: 
o Select the CD-ROM drive using Start and Run, My Computer, or Windows 

Explorer. 
 

o Double click on setup.exe from My Computer or Windows Explorer; click 
OK in Run. 

 

 If the setup sequence starts automatically, click on the JMS icon. 
o Some computer operating systems will 

show a security warning.  If the CD 
came from AZI or one of its authorized 
distributors, in the same packaging as 
the Jerome 651, or was received directly 
through the mail, click on the “YES” 
button.  

 If you are still not able to install the software: 
o Check that your browser's security 

settings allow you to download software.  
If your security settings are set too high, 
you will not be able to download any 
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executable programs by way of your browser.  If you set them at a 
medium level, you will be able to download the software. 

o Please see the Help menu in your 
browser for more information on 
security. 

 If you are still unable to install the software: 
o Use My Computer to select the CD 

drive containing the AZI software 
disk. 

o Double click on setup.exe 
 

 
o Call AZI Customer service at 800-528-7411, 602-470-1414, or e-mail 

support@azic.com for assistance. 
 

 

 The setup confirmation message will display. 
 

 Click “YES” to continue installing JMS  
o The welcome message will display. 

 
 

  Click “NEXT” to continue the JMS 
installation 

o The license agreement will display.  
Please read the license agreement 
carefully. 

 
 
 
 
 
 
 
 

 If you agree to the terms of the license, 
select “I accept the agreement”, and click 
“Next.” 

o The destination directory dialog will 
display.  It is recommended that you 
accept the default settings. 

 
 
 
 
 

mailto:support@azic.com
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 Click “Next” to continue 
o The start menu dialog will display.  

This will determine where the JMS 
Start shortcut will be placed in your 
start menu.  It is recommended you 
accept the default settings. 

 
 
 
 
 

 Click “Next” to continue 
o The select additional tasks dialog will 

display.  Check the "Create a 
Desktop Icon" box if you want to 
create a shortcut to JMS on your 
desktop.  

 
 
 
 
 
 
 
 
 
 
 

 Click “Next” to continue 
o A screen with your selected items is 

displayed.  Verify the information is 
correct. 

 

 Click “Install” to install JMS using these 
settings. 

o The installation of JMS will start. 
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 When the installation is complete, the Setup 
Complete dialog will appear. 

o Check the Launch AZI Jerome 
Monitor Software box to start JMS 
immediately or uncheck the box if 
you are not ready to run JMS. 

 Click “Finish”. 

 When the JMS starts up, it will wait 20 
seconds before communicating with the 
651 in case the user wants to change 
default settings. 

 

 

NOTE:  On some Windows operating systems, a box may be displayed asking if 
you want to reboot or restart the computer at this time.  Select YES to restart and 
finalize the installation. 

 

12. LAUNCHING JMS 

 
The JMS software can interface with the Jerome 651 Fixed Point Hydrogen Sulfide 
Monitor as well as the Jerome 451 Fixed Point Mercury Monitor.  If your application 
involves only Hydrogen Sulfide monitoring, you can ignore the Mercury related 
options available from JMS.  However, if your application would benefit from Mercury 
monitoring as well, a Jerome 451 instrument can be implemented in the system, and 
both the 451 and 651 can be controlled from one installation of JMS.  Over 500 
Jerome 451/651 instruments can be connected to the network of instruments. 
Operating JMS is the same whether 651‟s, 451‟s or both are in use. 
 

 To Start JMS: 

 Double click on the Jerome Monitor Software icon located on the 
desktop. 

 Or, select “Programs/AZI/Jerome Monitor Software” in the Start 
menu. 

To install or operate JMS, the user must be an Administrator on the target PC. 
The following information regarding the configuration and use of JMS is also available 
from the Help system within JMS. 
 

13. JMS INITIAL SETUP 

 
In this section: 

First Time Port Selection 
Adding Instruments 
Verify Radio Contact 
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First Time Port Selection 

 The first time the Jerome Monitor Software (JMS) is run you will see the 
following dialog box:  

 
 
 
 
 
 
 
 

 Select the COM port (or serial port) on your computer that your radio is 
connected to. 

 Select the radio modem type that you have connected to your PC: Spectra.  
(The XStream and XTend Radio modems have been discontinued.) 

 Select the radio channel that your Jerome 651 (and/or 451) instruments are 
using.  
o See the 651 USER INTERFACE section for information on programming 

the radio from the instrument‟s control panel.  All radios (in each 
instrument and at the Base Station computer) must be on the same 
channel.  If you experience poor communications there may be 
interference.  Trying a different radio channel may improve communication 
with the Jerome 451/651 instruments. 

 Click Continue. 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: You must REBOOT or EXIT the JMS software in order to 
establish communications for the first time after software installation. 
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Adding Instruments 

 
After choosing a COM port and radio channel, add your Jerome 451/651 instrument 
to the instrument list in the Jerome Monitor Software window (pictured below), by 
following these steps: 
 

 
 
 
 
  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

1. Click Add a new instrument to poll.  The following dialog box will appear.  
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Instrument Location Name: Enter a name to identify this instrument's location.  
 
Gas:  Select H2S for 651 instruments (or Hg for 451 instruments). 
 
Instrument Radio Address: Enter the address that this instrument is programmed 

on.  See 651 INSTALLATION on page 11 for more information on programming 
from the instrument‟s control panel. 

 
Enable Polling: This is usually checked.  Leave it unchecked if this instrument is 

offline.  
 
Sample Instrument every --- minutes.  Valid values are 1, 2, 5, 10, 15, 30, 60, and 

120 minutes. 

 
Regenerate Instrument Every --- hours.  Valid values are 6, 12, 24, and 48 hours.  

The default is 48 hours.  An interval less than 48 hours will shorten the life of the 
gold film sensor in the 631-X (or 431-X).  

 
First Regen Time at: The default is 12AM. 
 
Examples: 

If the regeneration interval is 12 hours and the first regen time is 5 AM, the 
regenerations will be at 5:00 AM and 5:00 PM. 
 
If the regeneration interval is 6 hours and the first regen time is 4 AM, the 
regenerations will be at 4:00 AM, 10:00 AM, 4:00 PM, and 10:00 PM. 

 
2. Click Save.  
 

Verify Radio Contact 

Note: Before communicating with the Jerome 451/651, make sure your computer's 
clock is set correctly.  JMS synchronizes the Jerome 451/651's internal clock with the 
computer's clock each time it polls data.  

To verify that Jerome Monitor Software can talk to the Jerome 451/651 instrument(s):  

 Make sure the radio has initialized.  
The Radio Log will say "Radio initialization complete." 
Note: This may take up to one minute.  

 

NOTE: Sample intervals less than 15 minutes will significantly reduce the 

life of the gold film sensor in the Jerome 631-X (or 431-X). 
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 Select an instrument from the Instrument List by clicking anywhere on the 
instrument's row.  Notice that some of the command buttons have now 
changed to include the location name of the instrument you have chosen.  

 Click the Take Sample From <instrument name> button. 
The Radio Log will report "Taking a manual sample from '<instrument name>' 
at address X". 
Approximately 35 to 40 seconds later, a message will be displayed showing 
the Hydrogen Sulfide (H2S) concentration (651‟s) or Mercury (Hg) 
concentration (451‟s).  JMS will then read the signal strength and report it in 
the Radio Log and Instrument List for the selected instrument.  

 
 Click the Poll instruments now button to download the 651 and 631-X serial 

numbers from the instrument. 
 

If you received a sample result back from your Jerome 651, the radios are 
communicating normally.  If not, check the JMS Online Help Guide under the 
Troubleshooting section for tips on resolving communication problems.  For assistance, 
contact AZI Customer Service at 800-528-7411 or 602-470-1414. 
 

14. JMS OVERVIEW 

 

The purpose of the Jerome Monitor Software is to allow you to download data from one 
or more Jerome 451/651 instruments, store it in permanent datafiles for future use, and 
display the data in table or graphical form. 

Jerome Monitor Software uses a Spectra radio modem connected to a PC or laptop to 
communicate with Jerome 451/651 instruments up to 4 miles1 away.  Jerome 451/651 
instruments store their sample results in internal memory until "polled" by the Jerome 
Monitor Software.  At that time, Jerome Monitor Software downloads all of the stored 
results and saves them to a permanent database on the PC or laptop.  The Jerome 
Monitor Software then displays the results in a table and on a graph. 

Jerome Monitor Software can be set to automatically poll Jerome 451/651 instruments if 
the PC is set up within range of them.  If an internet connection is also present, Jerome 
Monitor Software can email high H2S or Hg alerts and notifications of system errors to 
email addresses you supply.  You can also manually poll Jerome 451/651 instruments 
in order to obtain the very latest data. 

Jerome Monitor Software stores the sample results (and wind direction and speed from 
the optional weather station) in a standard Microsoft® AccessTM database.  The 
database is stored in a default system location that all users have access to.  This 

                                            
1 Radio line-of-sight, including the Fresnel Zone.  This is not the same as visual line-of-sight.  Any 

obstructions between the radio antennas will reduce the effective distance at which they can 
communicate.  
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default location may vary depending on the version of Windows on your computers.  
The datafile can also be stored in a folder you specify on your computer or network. 

Current stored data can be loaded into Jerome Monitor Software and viewed in tabular 
or graphical form.  Jerome Monitor Software can automatically refresh the data after 
polling the Jerome 451/651 instruments.  Historic data can be viewed using the 
reporting feature. 

The table on the Data tab in the Jerome Monitor Software main window shows all data 
points downloaded from your Jerome 451/651 instruments.  You can filter the table to 
only see error messages or 651 Functional Test Module (FTM) and 451 Functional Test 
Kit (FTK) readings.  The data can also be sorted in ascending or descending order by 
clicking the column header. 

The graph on the Graph tab in the Jerome Monitor Software main window shows actual 
sample data without any error messages or FTM/FTK readings.  Data from 451 (Hg) 
instruments or 651 (H2S) instruments can be viewed separately.  Since they use 
different units, they cannot be viewed together on the same graph.  The solid lines and 
vertical scale on the left side show the Hg or H2S gas concentration.  If you have 
selected to view temperature data, you will have dotted lines and a scale on the right 
side of the graph for temperature.  If you are looking for trends in the data, say a high 
reading at about the same time every day, the Jerome Monitor Software can overlay 
data from time periods you choose on the same graph.  The time scale at the bottom 
will show 00:00 to 23:59 hours if overlay days is selected, or Sunday through Saturday if 
overlay weeks is selected.  If there is a daily or weekly trend in the data it will show up 
on an overlay graph. 

In this section:  

The Graph Tab 

The Data Tab  

The Radio Tab 

The Radio Status Window 

The Maintenance Tab 

The Site View Tab 

The Menus 
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The Graph Tab 

 

 
The Jerome Monitor Software is used for both the Jerome 451 (Mercury 
Monitoring System) as well as the Jerome 651 (Hydrogen Sulfide Monitoring 
System).  The display above is for the Jerome 651 instrument.  The titles and 
units will change according to the selection of H2S or Hg instruments below 
the graph, but everything else is the same whether 451’s, 651’s, or both are in 
use. 
 
The numbered items (1-7) below correspond to the above diagram. 

1. H2S gas concentration scale  
2. H2S gas curve  
3. Temperature scale  
4. Temperature curve  
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5. The selected data point (cursor).  The cursor can be moved right and left on the 
same curve using the right and left arrow keys.  The cursor can be moved to 
different curves on the graph using the up and down arrow keys.  

6. Details of the selected data point  
7. Alarm limit: A line that marks the alarm limit set in Program Options in JMS. 

The Data Tab 

 

 
 

The Datagrid: This is where the data downloaded from the Jerome 451/651 
instruments are displayed.  Columns can be sorted in ascending or descending order by 
clicking on the column header.  Up to two columns can be sorted.  The amount of data 
displayed is set in the Program Options (available by selecting Options in the Tools 
menu). 
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The Radio Tab 

 

The Spectra radio modem is the link between the Jerome Monitor Software and the 
Jerome 451/651 instruments.  It allows the Jerome Monitor Software to do the following:  

1. Remotely program the Jerome 451/651‟s sample interval, regeneration interval, 
and regeneration time.  

2. Remotely instruct the Jerome 451/651 to take a manual sample and report the 
result in Jerome Monitor Software.  

3. Download stored sample results and optional weather station data.  

General guidelines:  

 All of the Jerome 451/651 instruments must be on the same channel for JMS to 
communicate with them.  

 Each of the Jerome 451/651 instruments must be set to a unique radio address 
and location name, but share a common Net ID.  

 The radio stations require line-of-sight communications for the maximum 
distance.  Any obstructions will reduce the radio range.  

 Using high-gain or directional antennas can increase this range.  The Radio 
Repeater Kit can also be used to extend the distance between the 451/651 
instrument and the Base Station.  For a more in-depth explanation about RF line-
of-sight see the section Fresnel Zone. 

The radio sends data in packets with error correction built in.  If a packet has errors 
(due to poor signal strength or interference), the radio resends that packet until it is 
received without errors or until it reaches the maximum number of radio retries, as 
set in JMS and at the Jerome 451/651 instrument.  If the packet is not received 
successfully, the downloaded data will not be complete.  If this happens, a message 
will be displayed in the radio log box on the Radio tab of JMS and the data for that 
instrument will not update.  The data is stored in the Jerome 451/651 and will be 
downloaded automatically during the next polling session when the radio signal is 
clearer.  
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The numbered items (1-4) below correspond to the above diagram. 

 

1. Instrument List -- Lists each Jerome 451/651 instrument that the Jerome 
Monitor Software communicates with.  See Adding Instruments in Initial Setup 
for instructions on how to configure each of these items.  

Name: A unique location name you assign to each Jerome 451/651.  

Gas: The gas type measured.  Hg for Jerome 451 instruments, and H2S for 
Jerome 651 instruments.  

631 SN: The serial number of the Jerome 631-X inside each Jerome 651 or 
431-X inside each Jerome 451.  

651 SN: The serial number of each Jerome 451/651.  
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Radio Addr: The radio address each Jerome 451/651 is programmed for.  It 
must match the address entered on the particular instrument's control 
panel.  

Status: Shows OK or ComError. 

Poll:  

Off: Polling is not enabled for this instrument.  

Manual: Polling is enabled for this instrument but Automatic polling is 
not enabled.  

Auto: This instrument will be automatically polled at set intervals.  

Sample Int: Jerome Monitor Software can program the sample interval for 
Jerome 451/651.  When you add or modify an instrument in the instrument 
list, you have the option of programming the Jerome 451/651 with the new 
sample interval.  

Regen Int: Jerome Monitor Software can program the regeneration interval 
for the Jerome 451/651.  When you add or modify an instrument in the 
instrument list, you have the option of programming the Jerome 451/651 
with the new regeneration interval.  

Regen Time: Jerome Monitor Software can program the time of day the 
Jerome 451/651 will begin its next regeneration cycle.  When you add or 
modify an instrument in the instrument list, you have the option of 
programming the Jerome 451/651 with the new regeneration time.  

2. Instrument list sort options.  The default is to sort by instrument name. 

3. Command buttons.  Here you can maintain the instrument list, poll instruments 
on the list (if polling is enabled) and manually take samples from instruments you 
select. 

4. Radio log.  Provides a general history of radio activity and events.  Notifications 
are displayed here when the radio is initialized, when each instrument is polled 
for data, and the results of a manual sample, among other things.  
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The Radio Status Window 

 
Available by selecting View Radio Events in the Tools menu. 

The numbered items (1-4) below correspond to the above diagram. 

The Radio Status window is used primarily for troubleshooting.  It allows you to view in 
real time the radio communications between JMS and the Jerome 451/651 instruments.  
The information displayed here can be very technical.  

1. Log Window: This is a running log of radio communication events.  
2. Clear Status Window button: Clears the log window.  
3. Radio log level: Lets you select how much information you want to see 

displayed in the log.  Smaller numbers mean less detail; larger numbers mean 
more detail.  

4. Radio command queue: Shows commands that have been started but not yet 
processed by the radio module of JMS.  Usually there will not be much here 
unless the JMS is polling instruments.  When polling you will see two commands 
per instrument: one to download the data and a second to get the signal strength 
of the last packet received from that instrument. 
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The Maintenance Tab 

 

 
 

Instrument List -- Lists each Jerome 451/651 instrument that the Jerome Monitor 
Software communicates with.  These are the same instruments as seen on the Radio 
Tab. 
 
Instrument List fields: 

 Name:  The instrument's location name. 
 Gas:  H2S for Jerome 651 instruments or Hg for Jerome 451 instruments. 
 651/451 SN:  Serial number of the 451/651 instrument. 
 631/431 SN:  Serial number of the 631-X or 431-X inside the instrument. 
 FTM/FTK Due:  Date the functional test module/functional test kit check is due. 
 Cal Due:  The date that the 631-X/431-X is due to be swapped out for 

recalibration. 
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FTM check reminders and Calibration reminders check boxes:  Enables the 
respective reminders.  When checked, use the arrows to adjust the number of days until 
the next reminder up or down.  The date in bold will change to show the date of the next 
reminder.  After that, reminders will occur at regular intervals as specified by Days until 
next FTM/FTK check and Days until calibration is due.  Click the Update button to 
set the reminder date.  NOTE:  If Delete data from the instrument after successful 
download is NOT selected in Radio Options, the date for the next FTM check will 
automatically update after polling based on the date of the last FTM check, according to 
the data stored in the 451/651.   
 
Check the Send email notification checkbox if you want to be reminded via email.  
Note: make sure your Email Options are set correctly.  If the FTM Check and Calibration 
reminders are both due at the same time, JMS will not send the second email reminder 
until the first reminder is acknowledged at the PC.  Use the Suppress Alarm option in 
Program Options to avoid having to acknowledge the first reminder in order to receive 
additional emails. 

 

The Site View Tab 
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This is a quick, easy-to-read representation of all the instruments on a site.  The top 
number on the instrument icon is the last reading taken.  The bottom number is the last 
time weighted average reading.  The readings are updated after polling.  The location 
name is below the icon.  The instruments can be moved on the window to show their 
position relative to one another. 
 
There is a radio tower icon which can be moved to show the relative location of the 
base station, and an arrow in the upper left corner that can be rotated to point North. 
 
If you have a picture of your site in JPEG format, you can use that as the background of 
the Site View tab. 
 
1. Place a copy of your JPEG in the Jerome Monitor Software program folder (usually 

C:\Program Files\AZI). 
 
2. Rename the JPEG to background 

 
3. Restart the Jerome Monitor Software and it will use that image as the Site View 

background. 
 
Note: If you have Windows set to display file extensions in your Folder Options, then 
rename the JPEG image to background.jpg. 

 

The Menus 
 
File Menu 
 

 

 Poll Instruments Now: Starts a manual poll of instruments that have polling 
enabled.  

 Print Plot: Prints the current graph.  

 Print Datagrid:  Prints the data from the Data Tab. 

 Printer Setup: Opens the Printer selection and setup dialog.  

 Save Plot Image As...: Save the current graph as a Bitmap or Jpeg image to disk.  

 Exit: Closes the Jerome Monitor Software 
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View Menu 
 

 

Graph  

 Normal graph view: Resets the graph to normal view.  See Overlay Graphs  

 Overlay graph weeks: see Overlay Graphs  

 Overlay graph days: see Overlay Graphs  

 

 

Instruments  

 All Instruments:  Displays all instruments in the Data Tab. 

 H2S Instruments:  Only shows H2S instruments in the Data Tab. 

 Hg Instruments:  Only shows Hg instruments in the Data Tab. 

 FTM Readings only:  Shows only FTM/FTK readings in the Data Tab. 

 Errors only:  Shows only instrument errors in the Data Tab. 

 Time weighted averages:  Displays the Time Weighted Averages view of the 
current data. 

 Auto scroll to newest data:  Auto sorts and scrolls the Data Tab datagrid to the 
most current data after a polling cycle. 

 Refresh:  Refreshes the Data Tab datagrid with the most recent data from the 
database similar to Auto scrolling.  Also resets the zoom on the Graph Tab graph 
and redisplays the current data. 
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Reports Menu 

 

 All Readings: Run a report that shows all normal readings, errors, and FTM/FTK 
checks from one or all instruments in a given date range.  See All Readings report. 

 Time weighted averages: Runs a time weighted averages report for one or all 
instruments in a given date range and a specified time interval to average over.  See 
TWA Readings report. 

 Calibrations: Runs a report that shows each time an instrument was swapped out 
for re-calibration.  See Calibrations report. 

 

Tools Menu 

 

 View error log: Displays a log of communication and instrument system errors.  

 View radio events: Opens the Radio Status Window. 

 Options: Opens the Options window 
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15. VIEWING DATA 

The data downloaded from the Jerome 451/651 instruments can be viewed in both table 
and graphical forms. 

The Data tab of the main Jerome Monitor Software window shows all data points or a 
filtered set of data points.  The data can be filtered to show data from all instruments, 
only H2S (Jerome 651) instruments, or only Hg (Jerome 451) instruments.  The data 
points can also be filtered to show only 431-X/631-X error notifications or only readings 
taken with the Jerome 651's Functional Test Module (FTM) or the Jerome 451's 
Functional Test Kit (FTK).  See OPTIONAL FUNCTIONAL TEST OF 651/631-X for 
more information on test procedures with the FTM or FTK. 

The Data tab can also show the time weighted average (TWA) of the most recent data 
from each instrument.  The time weighted average takes the last 30 minutes to 24 hours 
of data (selectable in the Program Options) and displays a running average in the data 
table. 

The Graph tab of the main Jerome Monitor Software windows shows the currently 
loaded data graphically. 

In this section:  

Table View (normal view)  

Table View (time weighted average) 

Graph View  

Overlay Graphs  
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Table View (normal view) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By default, only 30 days of data are displayed on the Data tab.  This setting can be 
changed in Program Options. 

Sorting 
Click on the top row of the column headers to sort by column.  Click once to sort in 

ascending order, indicated by a "▲" in the column header.  Click a second time to sort in 

descending order, indicated by a "▼" in the column header.  Up to two columns can be 

sorted. 

Filtering 
Select one of the options in the View menu to easily filter the data in the table.  

Printing 
Click the File menu, then Print Datagrid to print the datagrid.  If you have used any of 
the filtering or sorting options, only the currently visible filtered or sorted data will print.  

Scrolling to newest data 
When the Auto Scroll To Newest Data option is checked in the View menu, the table 
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will sort by date in ascending order and scroll to the bottom of the data after a polling 
cycle is completed, if the refresh data option is selected (see Radio Options). 
 

Loading current data 
To clear the datagrid and reload the latest data, click the Refresh from the View menu 
or hit the F5 key.  This will reload the data for the Jerome 451/651 instruments on the 
instrument list on the Radio tab.  
 

Table View (time weighted average) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sorting 
Click on the top row of the column headers to sort by column.  Click once to sort in 

ascending order, indicated by a "▲" in the column header.  Click a second time to sort in 

descending order, indicated by a "▼" in the column header.  Up to two columns can be 

sorted. 

Printing 
Click the File menu, then Print Datagrid to print the datagrid.  If you have used any of 
the sorting options, the data will print sorted.  

Loading current data 
To clear the datagrid and reload the latest data, click Refresh from the View menu or 
hit the F5 key.  This will reload the data for the Jerome 451/651 instruments on the 
instrument list on the Radio tab.  
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Graph View 

Elements of the graph 
The graph shows H2S or Hg readings, and temperature curves for the data that is 
currently loaded in the Jerome Monitor Software.  The solid lines graph the H2S or Hg 
concentration (using the vertical scale on the left) depending on which instrument gas 
type you are currently viewing.  If you have selected to graph temperatures (see Graph 
Options), the dotted lines are the temperature curves (using the vertical scale on the 
right).  You can select Celsius or Fahrenheit temperatures from the Graph Options.  To 
view outside wind temperature data, the optional Anemometer (AZI # 980-0010) must 
be installed.  The horizontal scale shows the date and time of the Jerome 451/651 
readings.  When you select a point on the graph a label will appear at the bottom of the 
graph showing the following:  

The Jerome 451/651 instrument name  

The date and time of the reading  

The H2S or Hg concentration  
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The internal temperature of the Jerome 451/651 (if internal temperature has been 
selected in Graph Options)  

If the Jerome 451/651 has the optional weather station you may also see:  

Outside temperature  

Wind direction and speed  

You can move the cursor right and left to select other points on the curve by using the 
right and left arrow keys.  You can move the cursor to other curves on the graph by 
using the up and down arrow keys.  

 

Zooming the graph 
Zoom in on an area of the graph by drawing a box around the area you want to see. 

 Position the mouse pointer at the upper left corner of the area you want to zoom 
in to.  

 Click and hold the left mouse button.  

 Drag the mouse pointer to the lower right corner of the area you want to zoom in 
to.  

 Release the left mouse button.  

To restore the graph to its default settings, select Refresh from the View menu. 
 
Printing 
Click the File menu, then Print Plot to print the graph.  If you have zoomed the graph, 
only the currently visible data will print.  
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Overlay Graphs 

Overlay graphs are used to identify trends in H2S or Hg readings. 
 
For example, consider the following normal graph with about one month's worth of data 
from a Jerome 651 called "Outside 2."  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note the spikes in H2S concentration.  It looks like there may be a trend.  To get a 
clearer view of the trend, create an Overlay Weeks view of the same data.  Go to the 
View menu, Graph submenu, and click Overlay graph weeks  
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The time scale at the bottom of the graph shows days of the week from Sunday through 
Saturday.  The scale may show Sunday 00:00 at the far right (as in this example) but 
data stops at Saturday 23:59.  You will have a different curve for each instrument, each 
week that it has data.  You can still select points and view the data recorded at the 
bottom of the graph as in the normal view.  The zoom feature and arrow keys for 
navigating the curves also work on overlay graphs.  

It looks like there may still be regular spikes.  For a close-up view of these spikes, 
create an Overlay Days view.  Go to the View menu, the Graph submenu, and click 
Overlay graph days  

 

The time scale at the bottom shows hours in the day from 00:00 to 23:59.  The scale 
sometimes goes to 00:00 at the very end (as in this example) but the data stops at 
23:59.  Now we can see that the spikes don't really show a trend.  However, H2S 
concentration does rise slightly between about 19:00 and 01:00.  In this example, the 
data was taken from a coastal region where the winds shift during daylight and 
nighttime hours.  
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16. JMS OPTIONS 

 

In this section:  

Program Options  

Radio Options  

Email Options  

Reporting Options 

Graph Options  

 

Program Options 

Available by selecting Options in the Tools menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Automatically start the Jerome Monitor Software when Windows starts: 
You must be a local administrator to change this setting.  
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Data display interval: How many days worth of data will be displayed on the Data Tab 
datagrid and the Graph Tab graph. 

Data file storage: 
Here you can select to store Jerome Monitor Software data files in the default system 
directory or specify another directory (folder) for them.  Any folder on a local or network 
drive is allowed. 

Time weighted average (TWA): Specify what time interval will be averaged when the 
datagrid is viewing TWA data.  For example, setting this to 30 minutes will average the 
last 30 minutes of readings from each instrument. 

Alarm options: 
Here you can set a high level alarm limit which will display on the graph and optionally 
send an email if the reading from an instrument is over the limit.  See Email Options for 
more information on sending emails.  You can set a separate high level alarm for time 
weighted average readings.  To enable the alarm and alert options for the 651, the box 
next to Enable H2S must be checked. 

High Verification Trend (HVT):  Checking the box to enable the alarm and alert 
options activates the High Verification Trend capability of JMS.  When polling 
completes, JMS analyzes the data, and if the last sample reading is higher than 
the instantaneous alarm level specified, JMS will initiate five manual samples at 
one minute intervals to verify the high reading.  This verification is initiated by 
JMS, so JMS and the 651 must be in constant communication for the verification 
to commence.  If there is a communication error, then the manual sampling 
feature cannot be initiated.   

To maximize the effectiveness of this feature, the polling frequency should be 
less often than the sampling frequency.  If the polling frequency is greater than 
the sampling frequency, it is possible to miss a high reading and thus manual 
verification sampling will not be performed. 

If a scheduled sample interval occurs during the five manual samples, the 
scheduled sample will be performed at the completion of that particular manual 
sample. 

You can also select to suppress alarm and error dialog boxes that may pop up during 
program operation.  This is useful when the Jerome Monitor Software is left to poll 
instruments unattended. 
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Radio Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instrument Polling Options: 

Poll instruments every --- minutes: This enables automatic polling of the Jerome 
451/651 instruments on the instrument list on the main window's Radio Options 
tab. Set the polling interval based on:  

How current you want the data  

How soon you want to be notified of a high reading (if email notifications is 
turned on.  See Email Options for more information.) 

Delete data from the instrument after successful download: If this is checked, 
Jerome Monitor Software will send a command to the Jerome 451/651 to delete 
its stored data only if the data was successfully downloaded, uncompressed, 
AND stored to permanent data files in the data directory.  

Refresh graph and data with latest poll data: If this is checked, Jerome Monitor 
Software will reload the current data in the datagrid and graph after a polling 
cycle is complete.  
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Radio: 

Com port: Select the serial or Com port on the computer that the host radio is 
connected to.  

Type: The radio type must match the model of radio connected to the PC - the 
Spectra radio modem.  (The XStream and XTend radio modems have been 
discontinued). 

Channel: The radio channel must match the channel that the Jerome 451/651 
instruments are set to.  Conflict with another radio network can be avoided by 
using a different hopping channel.  

Retries: Set the number of times the radios will resend a packet if an error occurs.  
Increase this number if signal strength is low or you suspect radio interference.  
The Retries setting in the Jerome 451/651 must match.  See the 651 USER 
INTERFACE section for information on programming the instrument from its front 
panel.  

Net ID: The Spectra radio modem can have its network ID changed to avoid conflicts 
with other existing radio networks.  

Power: The Spectra radio modem can have its transmit power reduced.  The FCC 
requires that lower power (< 1W) be used if a high gain antenna is used. 
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Email Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Server information - Ask your network administrator or IT department for these 
settings.  

SMTP Server - DNS name or IP address of your SMTP email server.  

SMTP Port - Port number your SMTP server listens on (default is 25).  

Use authentication - Check this box if you need to log into your SMTP email server.  

Logon Information: The user name and password may or may not be the same as 
you use to access your email.  

User name - Used to log into your email server.  

Password - Used to log into your email server.  

Sender information  

Name - The name that you want to appear in the "FROM:" section of email 
notifications.  
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E-Mail address - The email address that you want to appear in the "FROM:" section 
of email notifications.  Note: Some spam filters will block emails if the "FROM:" 
email address is the same as the "TO:" or "CC:" address.  

To (receiver of e-mail)  

Priority: Used by most email systems to mark important emails.  

Subject: The subject of the alert email.  

To: One email address to send alerts to.  This may be a distribution list if your email 
system supports them.  

CC: One email address to receive a "carbon copy" of the email.  This may be a 
distribution list if your email system supports them.  

Message 
 
The scrolling text box contains the body of the email alarm notification.  It can contain 
both text and macros (see Email Macros in the reference section).  The default text, 
which includes all sample information, can be customized to provide the recipient with 
just the information your organization requires. 

Restore default message - resets the message text to send all sample information.  

Insert Macro - inserts a macro that automatically fills in specific sample information.  
Select a sample parameter from the drop down list then click this button to place 
the selected macro at the current cursor location in the text.  

 
Send Test Email - Verify your email settings by sending a test email to all 

recipients. 
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Reporting Options 

 

Custom report header text:  Anything typed on these 3 lines will appear on the header 
of all reports.  A common use is to add a company's name and address to a report.  
Here is an example of a report header: 
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Graph Options 

 

Mark data points on graph: 
Marks each data point with a filled-in diamond shape. 

Scale Y-axis when zooming: 
Normally, when you zoom in on a graph, the Y axis retains the same scale.  In other 
words, it zooms only on the X axis.  Checking this box allows you to zoom in on the Y 
axis as well. 

Cursor displayed when selecting a data point: 
Selects the shape of the cursor that identifies the selected data point on the graph.  

Cursor color: 
Allows you to change the color of the cursor that identifies the selected data point on the 
graph.  
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Gas curve scale options: 
Allows you to either let Jerome Monitor Software autoscale the H2S or Hg concentration 
Y axis to fit all data points or specify a fixed maximum gas concentration.  (Note: If the 
graph is not in autoscale mode, the minimum Y axis H2S and Hg concentration cannot 
be less than 0.)  

Upper gas reading limits:  

Display gas "High Level" line - Displays a blue line at the high level value 
specified on the Program tab.  

Mark out of limit points in black and display an alert - Any portion of the H2S or 
Hg gas concentration curve that is above the High Level line will be displayed in 
black.  Also a "High Gas" alert popup message box will be displayed unless the 
Jerome Monitor Software is running in "unattended mode" (see Program 
Options).  

Temperature to graph:  

None - No temperature curve or scale is displayed  

Outside - A temperature curve and scale is displayed for outside (or wind) 
temperature if using the optional weather station.  

Internal box - A temperature curve and scale is displayed for the temperature inside 
the Jerome 451/651.  

Temperature units: 
Select the units to display temperature on the graph and datagrid.  

Line color palette: 
Select the color scheme for line colors on the graph.  
 
 

Reporting 

 
Reports can be run to show any data downloaded from the Jerome 651 and 451 
instruments, as well as calculated time weighted averages and maintenance 
information.  Custom header text for each report can be set in the Reporting Options. 
 
In this section: 
 

All Readings 
TWA Readings 
Calibrations 

 
The reports are accessed from the Reports menu on the toolbar. 
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All Readings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Any data downloaded from a Jerome 651 or 451 can be viewed with the All Readings 
report.  This includes: 
 Normal instrument readings 
 FTM/FTK checks 
 Instrument or system errors 

 
The report data can also be filtered by the following criteria: 
 Instrument:  A single instrument or all instruments 
 Date/Time range:  Specify a start date and time and an end date and time. 
 High limits set at the time the report is run, independent of the high level limits set in 

Program Options 
 
Below is a sample of an All Readings report: 
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NOTE:  If WIND functionality is not enabled at the instrument, wind speed and direction 
will be displayed as “-1” and wind temperature will be “0.0” in an All Readings report, 
though all three wind items will continue to show as blanks on the Datagrid. 
 

TWA Readings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A time weighted average is the average of all normal readings in a specified time 
interval.   
 
The possible intervals are: 
 
 30 minutes 
 1 hour 
 2 hours 
 4 hours 
 8 hours 
 12 hours 
 24 hours 

 
The report data can also be filtered by the following criteria: 
 
 Instrument:  A single instrument, or all instruments 
 Date/Time range:  Specify a start date and time and an end date and time. 
 High limits set at the time the report is run, independent of the high level limits set in 

Program Options 
 
The time weighted average report will start at the first time interval on or before the start 
date/time.  A line item on the report will be generated for each interval thereafter.  For 
example, for 30 minute intervals, a line item will be created for 12:30 am that contains 
an average of the readings from 12:01 am to 12:30 am. 
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In the event that there is no data during that interval, no line item will be generated.  If 
there is partial data during an interval, an average will be calculated on the data that is 
present and a line item created for that interval. 
 
Below is a sample of a Time Weighted Average report: 

 

Calibrations 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Calibrations report shows when the internal 431/631 instrument is removed for 
recalibration and a freshly calibrated instrument installed in its place.  The new 431/631 
serial number must be entered in the 451/651 control panel on the front if the instrument 
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in order for the Jerome Monitor Software to detect the change.  The Jerome Monitor 
Software will detect the new 431/631 serial number when it polls the instrument for data.  
JMS will record the following information in its database: 
 
 The last 431/631 serial number 
 The new serial number 
 The date and time the data was polled. 

 
Below is a sample of a Calibrations report: 

 
 

Reference and Troubleshooting 

In this section:  

Email Macros  

Troubleshooting  

Fresnel Zone (Radio line-of-sight) 
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Email Macros 

 
 

Macro Description 

%InsName% Instrument location name 

%InsSN% Jerome 451/651 serial number 

%InsRadioID% Jerome 451/651 radio address 

%ReadTime% Time the sample was taken 

%ReadTempF% Jerome 451/651 internal temp.  in °F 

%ReadTempC% Jerome 451/651 internal temp.  in °C 

%ReadGas% H2S or Hg gas concentration 

%Units% H2S or Hg units 

%WindDir% Wind direction 

%WindSpd% Wind speed (in miles per hour) 

%WindTmpF% Outside temperature in °F 

%WindTmpC% Outside temperature in °C 

%PCAlarmLvl% High Level alarm value 

%031SN% Jerome 431-X/631-X serial number 
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Troubleshooting 

 If the radio will not initialize: 
Check the connection to the PC Com port in Radio Options. 
Check that the Jerome Monitor Software is set for the correct Com port. 
 
If there are “com errors” reported by one or more instruments: 
Verify that the Jerome 451/651 is set up correctly according to the manual. 
Check that the correct radio type (Spectra) is selected in the Radio tab of the 

JMS options. 
Check that JMS and the Jerome 451/651 instruments are on the same radio 

channel. 
Check that the radio address in the instrument list on the Radio Options tab (of 

the main window) in JMS matches the radio address on the Jerome 451/651. 
Check the position of the radio antenna on the host radio and the Jerome 

451/651.  Make sure that there is line-of-sight visibility and that the 
equipment is within the working range of the radio.  (See Fresnel Zone). 

 
If JMS is consistently2 encountering errors while downloading sample data, 
try the following: 
Check the position of the radio antenna on the host radio and the Jerome 

451/651.  Make sure there is line-of-sight visibility. 
Try setting JMS and the 451/651 to a different channel.  If there is interference 

from another radio source, using a different channel may avoid it. 
Increase the number of radio retries under Radio Options and on the 451/651. 
Verify that the Language setting in the Windows Control Panel is set to „English.‟ 
 
The date and/or time of downloaded sample data is wrong. 
Check the system clock of the computer running JMS.  JMS synchronizes the 

451/651‟s internal clock with the computer‟s clock each time it polls data. 
 
Verify that your system meets the requirements necessary to run JMS: 
Windows XP with 128 MB RAM (256 MB recommended) 
25 MB free space on C: (100 MB recommended) 
JMS is NOT Windows Vista compatible 
JMS has been tested under US-English versions of Windows.  Compatibility with 

other language versions cannot be guaranteed. 
 
To install or operate JMS, the user must be an Administrator on the target 

PC:  See your IT department for assistance. 
 
 
 

                                            
2
 Occasional communication errors due to interference are normal in urban areas or in bad weather.  The 

Jerome 451/651 will store sample data until the radio is clear enough to send it. 
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Fresnel Zone 

 
Radio Frequency (RF) line of sight is required to achieve maximum range with the 
Spectra radios used with the Jerome 451 and 651 instruments.  RF line of sight differs 
from visual line of sight as shown in Figure 1 and Figure 2 below.  The Fresnel Zone is 
an elliptical volume of space between the two antennas.  Any objects within this space 
will block a portion of the signal and the radios will not be able to transmit to their 
maximum range. 
 
If the antennas are low enough, the ground itself will block the signal  
(see figure 1, Note: drawings not to scale).   
 

 
Placing the antennas higher up will prevent the ground from entering the Fresnel zone 
and improve the radio signal (see figure 2, Note: drawings not to scale). 
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Table 1 below, provided by MaxStream, shows the diameter of the Fresnel Zone for 
2400 MHz radios at different distances.  This can be used as a guide to help determine 
how high to place your antennas if you are experiencing radio communication problems 
with the Jerome 451/651 instruments. 

Table 1.  Fresnel Zone Diameters  

 

Range 
Distance  

Required 
Fresnel Zone 

Diameter 
(Spectra 2400 

MHz Radios)  
 

1000 ft. (300 m)  11 ft. (5.4 m)  
1 Mile (1.6 km)  21 ft. (8.4 m)  
5 Miles (8 km)  43 ft. (15.2 m)  

10 Miles (16 km)  59 ft. (20.2 m)  

 
The basic rule is to make sure the combined height of the base station and Jerome 
451/651 antennas is greater than the diameter of the Fresnel Zone. 
 
Buildings and trees in the Fresnel Zone can also block a portion of the signal.  Trees are 
a particular problem for 2400 MHz radios.  Although 2400 MHz signals can pass 
through walls, they have a harder time passing through trees due to the water content.  
Walls are very dry and trees have a high level of moisture, and 2400 MHz radio waves 
are absorbed by water. 

 

17. FLOW PUMP KIT 

A Flow Pump Kit (AZI #Y990-0195) 
is available for the 651.  The Flow 
Pump Kit has the ability to draw air 
for sampling over a long distance 
and still provide continuous real-time 
readings.  Contact your AZI 
Technical Sales Representative at 
800-528-7411 or 602-470-1414 for 
more information. 

Line power of 100-240V AC, 50/60 
Hz must be run to the marked 
connections of the terminal block in 
the flow pump.  Maximum current 
draw is 1 Amp. 
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INSTALLATION: 

1. The flow pump should be mounted a minimum of 6” higher than the “T” fitting. 
2. Cut three (3) pieces of 3/8” OD Tubing to the appropriate lengths to be used where 

indicated in red in the diagram below: 
 From the measurement point to the flow pump inlet. 
 From the flow pump outlet to the included “T” fitting (AZI #1300-0062) 
 From the “T” fitting as an exhaust outlet to an ambient pressure location. 

3.  If using soft tubing, install the included inserts (AZI #1300-0064) in the ends of the 
tubing where it will connect to the flow pump and the “T” fitting.  (The inserts prevent 
the tubing from being pinched shut). 

4.  Install the tubing where indicated and tighten the compression nuts to hold the tubing 
in place.   

5.  Connect the “T” fitting to the 651 intake and tighten the compression nut to secure it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

"T" Fitting (AZI # 1300 0062) 

Flow Pump 

651 

Note:  If it is necessary to loosen the collet (7/64” Allen 
wrench) and extend the stainless steel inlet tube in order 
to have sufficient clearance to attach the “T” fitting, please 
leave the maximum stainless steel tube length inside the 
case to cool and condense possibly moisture laden 
sample air. 
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SIGNAL RELAY 4 TO 20 mA 

18. 4-20 MILLIAMP AND SIGNAL RELAY CONNECTIONS 

The 651 provides both a 4-20 mA connection and a signal relay connection on the 
circuit board.  Remove the two screws securing the Circuit Board Cover to access these 
connections on the circuit board. 

 
 
Once the desired connections have been implemented, replace the Circuit Board Cover 
and two screws. 
 

4-20 mA 

 
The 4-20 mA connection can be used to indicate the H2S reading level on a proportional 
scale from 4-20 milliamps for connection to certain industrial systems, such as SCADA. 
 
A 4 mA current level always corresponds to an H2S reading of 0.000 ppm.  The 20 mA 
level can be set as high as the maximum reading level for the 651 (50 ppm) or 
somewhere between 0.000 and 50 ppm, depending on your application.   
 
The 20 mA current level must be set to an H2S reading level before the 4-20 mA 
connection can be used.  This value can only be set at the 651, and cannot be set using 
Jerome Monitor Software (JMS).   



Page 69 of 80 

 Select 4-20 MAX from the SAMPLE menu to assign the H2S concentration (in 
ppm) for the 20 mA level. 

 
After the 20 mA level has been set, the following equation can be used to determine the 
H2S reading based on the level of current. 
 

 H2S concentration detected = (current in mA - 4) x (4-20 MAX value)/16 

 
For example, if the 4-20 MAX value is set to 50 ppm, the equation becomes: 
 
    H2S = (current in mA - 4) x (50/16) 
 
Thus, in this example using a 4-20 MAX value of 50 ppm, a 20 mA current corresponds 
to an H2S concentration of 50 ppm, while a 12 mA current corresponds to an H2S 
concentration of 25 ppm. 
 
The 4-20 mA connection is passive and must be powered by an external 12 V DC 
power supply.  An example setup is shown below. 
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Signal Relay 

 
The signal relay connection is an electrical switch that can be closed by the 651 when 
the 651 reads H2S levels greater than or equal to the value set in ALRM LVL in the 
SAMPLE menu on the 651.  This level can only be set at the instrument, and cannot be 
set using JMS.   
 
An appropriate audio or visual alarm can be connected to the signal relay.  When the 
sample reading exceeds the designated level, the switch is closed, activating the 
connected alarm. 
 
An example setup using the signal relay is shown below.  The connected power supply 
cannot exceed 24 Volts DC and 1 amp of current or 12 Volts AC and 1 amp of current. 
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19. POTENTIAL INTERFERENCES 

For some applications, the Jerome Hydrogen Sulfide monitoring system may be 
installed in locations where foreign compounds are present.  Depending on the foreign 
compounds present, in some cases erroneously high readings may occur. 

In areas where chlorine gas is present, Arizona Instrument recommends the installation 
of a Jerome Chlorine Filter Kit (AZI #Y990-0200).  When installed, this filter will remove 
the chlorine gas from the sample stream so that the Jerome monitoring system can 
accurately measure levels of Hydrogen Sulfide. 

An Ammonia Filter Kit (AZI #Y990-0201) is also available for locations where ammonia 
may be present. 

For pricing and delivery information on the chlorine and ammonia filters, contact AZI 
Jerome Sales at 800-528-7411. 

NOTE:  PLEASE READ THE DATA SHEETS INCLUDED WITH THE FILTERS FOR 
PROPER INSTALLATION AND USE OF THE CHLORINE AND AMMONIA FILTERS. 

Filter data sheets are also available online at the AZI website http://www.azic.com/. 

Ammonia Filter Kit for the 651 

 

 

 

http://www.azic.com/
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INSTALLATION of Chlorine or Ammonia Filter Kit: 

1. Disconnect the tubing between the 631-X intake and the Vacushield filter from the 
Vacushield filter. 

2. Connect the Chlorine or Ammonia filter between the Vacushield filter and the intake 
of the 631-X as shown in the pictures above and below. 

3. Position the filter as shown to determine where to mount the Kwik Clip. 
4. Peel the covering off of the back of the Kwik Clip and mount the clip to the cover 

below the 651 keypad. 
5. Position the Chlorine or Ammonia filter in the Kwik Clip. 
6. Use the included Wire Tie to secure the tubing as indicated, but do not tighten the 

wire tie or the flow will be restricted. 

 

 

 

 

 

 

 

 

 

 

 

 

Install Wire Tie around both tubes to secure tubing  

 

 

 

 

Jerome 651 with an Ammonia Filter installed 



Page 73 of 80 

20. MAINTENANCE 

U.S. CUSTOMERS (Instruments sold within the continental United States) 

Under continuous use, the 631-X gold film sensor is warranted to last for 3 months with 
a 15-minute sample interval and 24-hour regeneration interval or to last for 6 months 
with a 30-minute sample interval and 48-hour regeneration interval.  During the 1-year 
warranty period, the sensor will be replaced free of charge with a maximum of 3 sensors 
during the 1-year period.  Any sensors that require replacement after the warranty 
period or the beyond the 3 sensor maximum will be replaced at the cost to the 
customer.  

Arizona Instrument LLC offers an annual maintenance agreement, which would cover 
all repairs, calibrations and sensors.  Please contact AZI customer service at 800-528-
7411, 602-470-1414, or e-mail at support@azic.com for details and assistance. 

In order to have continuous operation of the Jerome 651 in the field, Arizona Instrument 
LLC offers a free loaner 631-X instrument during the 1-year warranty period or under 
the maintenance agreement.  Please contact AZI customer service at 800-528-7411, 
602-470-1414, or e-mail at support@azic.com for details and assistance. 

The VACUSHIELD filter (AZI # 800-0065) is required to be replaced when the 631-X is 
recalibrated or after approximately 3 months of continuous use. 
 
OUTSIDE THE U.S. CUSTOMERS (Instruments sold outside the continental United 
States) 

 
Questions regarding maintenance and warranty support for instruments sold outside the 
continental United States need to be directed to your local AZI representative or Arizona 
Instrument LLC customer service at 800-528-7411, 602-470-1414, or e-mail at 
support@azic.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:support@azic.com
mailto:support@azic.com
mailto:support@azic.com
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21. APPENDIX A: RADIO REPEATER SETUP 
 
 
For users with Spectra modems who have purchased the Radio Repeater Kit (AZI # 
Y990-0203).  Contact your Arizona Instrument technical sales representative for more 
information on the Spectra modem or the Radio Repeater Kit. 
 
The Radio Repeater Kit contains the Radio Repeater (pictured below) and the software 
required to program the Radio Repeater.  The Radio Repeater can be used to extend 
the distance between the base station and the 651(s) (and/or 451(s)).  For example, if 
you are placing 651‟s over a large area with a high mountain nearby, you can increase 
radio range by locating a repeater on top of the mountain.  For best results, use high 
gain directional outdoor antennas (AZI # 200-0174) on the base station and 651‟s, with 
the antennas pointed towards the repeater on the mountain.  See Base Station Setup 
on page 15 for information about setting up outdoor/external antennas at the base 
station and see Outdoor/External Antenna Setup on page 13 for information about 
setting up outdoor/external antennas at the 651. 

Line power of 100-240V AC, 50/60 Hz must be run to the marked connections of the 
terminal block in the radio repeater enclosure.  Maximum current draw is 1 Amp. 

 

Radio Repeater with line power wired to the Terminal Block 
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Before the Radio Repeater can be used in the field, it must be programmed using a PC 
running the included Radio Repeater Setup software (AZI # 710-0051). 
 
The Radio Repeater Setup software requires a PC with: 
 a 32-bit version of Windows XP 
 a 1.0 GHz or higher processor 
 196 MB of RAM (256 MB recommended) 
 200 MB of available hard disk space 
 An available serial port 
 The .NET framework (installed by the Radio Repeater software if necessary) 

Please see your IT department if you have any questions about your PC‟s capabilities. 
 
1.  Connect the included Radio Data cable (AZI # 200-0182) to the matching connector 
between the antenna connection and the power connection on the right side of the radio 
modem. 
 
2.  Connect one end of the included Serial cable (AZI # 200-0038) to the free end of the 
Radio Data cable, and connect the other end of the Serial cable to the PC to be used to 
program the Radio Repeater. 

3.  Make sure power is connected to the Radio Repeater. 
 
4.  Next, install the Radio Repeater Setup software (AZI # 710-0051) on the PC.  When 
the CD is inserted, the software installer should launch automatically.   
 If it does not, find and launch setup.exe on your CD-ROM drive using My 

Computer, Windows Explorer, or StartRun. 
 
5.  Follow the onscreen prompts to install the Radio Repeater software. 
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6.  Once installation is complete, launch the Radio Repeater Setup software, using the 
Arizona Instrument folder on the Start Menu, or the icon on the desktop. 
This screen will appear when the software is launched. 

 
 
To program the Radio Repeater, make the appropriate selection in each drop-down 
box: 

 PC Com port: Set the serial or communications port on the computer that the radio 
is connected to.  

 

 Radio Type: Specify the radio type that is connected to the PC.  For now, this 
program will only program the Spectra radio modem.  

 

 Radio Address: Set the radio address to a unique number.  Every repeater and 651 
radio must have a unique address.  
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 Radio Primary Channel: Set the radio primary channel to the base station radio 
channel.  
NOTE - If this radio does not directly talk to the base station radio but to a 
previous repeater radio that talks to the base station radio, then set this radio's 
primary channel to the previous repeater radio's secondary channel.  

 Radio Secondary Channel: Set the radio secondary channel to the following slave 
radio‟s channel.  
NOTE - If this radio does not directly talk to the following slave radios but to a 
following repeater radio that talks to the following slaves, then set this radio's 
secondary channel to the following repeater radio's primary channel.  

 Retries: The number of times that the radios will resend a packet if an error occurs.  
All radios in the network must have the same value.  Typically set this to 5.  

 

 Net ID: The radio modems can have their network ID changed to avoid conflicts with 
other existing radio networks.  All radios in the network must have the same 
value. 

 

 Power: Set the radio transmit power.  Reduce transmit power as required by local 
radio regulations.  In the USA, the FCC requires that lower power (< 1W) be used 
if a high gain antenna is used. 

 
Once all of the configuration options have been set appropriately, click the “Program 
Radio Modem” button.  The Radio Modem Communications window will show the 
communications between the PC and Radio Repeater during programming.   
 
If the programming is successful, the PC will display a dialog box reading “Modem is 
configured and ready to be installed.”  Disconnect the serial cable and radio data cable 
from the PC and the Radio Repeater, and install the Radio Repeater in the field for use. 
 

Example Network 

 

Refer to the diagram of an example network on the next page. 
 
To extend the distance between the base station and the 451/651‟s at addresses 5 and 
6, the repeater at address 2 is used. 
 
A 651 (or 451) with a Spectra radio can also be configured as a repeater.  In the 
example network, the 451/651 at address 3 is used to reach the 451/651 at address 4.  
To configure a 651 (or 451) as a repeater, set the SYSTEM/FACTORY/RADIO menu 
item at the 651 to “SPECTRA RP” (instead of “SPECTRA”), and then set the NET ID, 
address, primary and secondary channels, and other radio parameters as appropriate 
using the SYSTEM/RADIO menu at the 651. 
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Pay particular attention to the radio channels in this example.  If there are no repeaters, 
then all the radio channels must be the same and there would not be any secondary 
channels. 
 
To increase radio range, an external 451/651 antenna can be used.  The standard 
451/651 antenna is replaced with a lightning arrestor that YOU MUST GROUND.  The 
external antenna is mounted above the 451/651 with a cable to the lightning arrestor.  
To provide additional lightning protection, install a lightning rod above the antenna to 
protect the system.  See Outdoor/External Antenna Setup on page 13 for information 
about setting up outdoor/external antennas at the 651. 
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22. WARRANTY 
 
 
Arizona Instrument LLC (seller) warrants to buyer that Jerome products (excluding the 631-X sensor) 
delivered pursuant to this agreement, at the time of delivery, and for a period of one (1) year thereafter, to 
be free from defects in material or workmanship and shall conform to seller's specifications or such other 
specifications as seller has agreed to in writing.  Under continuous use, the 631-X sensor is warranted to 
last for 3 months with a 15-minute sample interval and 24-hour regeneration interval or to last for 6 
months with a 30-minute sample interval and 48-hour regeneration interval.  For further information and 
maintenance agreements, contact AZI Customer Service at (800) 528-7411 or e-mail to 
support@azic.com.  Internationally, call (602) 470-1414 or fax (480) 804-0656.  Seller's obligations with 
respect to claims under this warranty shall be limited, at seller's option, either to the replacement of 
defective or non-conforming product or to an appropriate credit for the purchase price thereof subject to 
the provisions of seller's Warranty Policy as amended from time to time, said Policy being incorporated 
herein by reference. 
 
Returned products under warranty claims will be shipped to seller‟s plant by buyer at buyer's expense and 
shall be accompanied by a statement of the reason for the return and an approved Return Material 
Authorization Number issued by seller.  Buyer remains responsible for payment for products not accepted 
for warranty adjustment, handling costs, and freight costs associated therewith. 
 
Notwithstanding the foregoing, no warranty shall be enforceable in the event that product has been 
subjected to environmental or stress testing by buyer or any third party without written approval of seller 
prior to such testing.  Further, no warranty shall be enforceable if the alleged defect is found to have 
occurred because of misuse, neglect, improper installation, repair, alteration, accident, or improper return 
handling procedure by buyer. 
 
Discontinued product is warranted only for a credit or replacement at seller's option. 
 
THE EXPRESS WARRANTIES GRANTED ABOVE SHALL EXTEND DIRECTLY TO BUYER AND NOT 
TO BUYER'S CUSTOMERS, AGENTS, OR REPRESENTATIVES AND, EXCEPT FOR WARRANTY OF 
TITLE, IS IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESSED OR IMPLIED, INCLUDING 
ANY IMPLIED WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE AND 
MERCHANTABILITY, SUCH OTHER WARRANTIES BEING SPECIFICALLY DISCLAIMED BY SELLER.  
IN NO EVENT SHALL EITHER PARTY'S LIABILITY FOR ANY BREACH OR ALLEGED BREACH OF 
THIS AGREEMENT EXCEED THE TOTAL EXTENDED PRICE OR PRICES SHOWN ON UNFILLED 
ORDERS, NOR SHALL EITHER PARTY BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM BREACH OR ALLEGED BREACH. 
 
Notwithstanding the foregoing, if any product covered by order(s) placed hereunder is designated as 
“developmental,” “prototype” or “experimental,” no warranty whatsoever except a warranty of title to 
component materials, will be applicable thereto and buyer shall indemnify seller for any claims for liability 
asserted seller in connection therewith. 
 
The foregoing state the entire liability of seller in connection with products supplied hereunder. 
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ARIZONA INSTRUMENT LLC 
 
 
 
TRADEMARK AND COPYRIGHT PROTECTION 

 

Copyright 2004-2008, Arizona Instrument LLC.  All Rights Reserved.  Jerome, Arizona 
Instrument, AZI and the stylized AZI are all registered trademarks of Arizona Instrument 
LLC.  All other trademarks are the property of their respective owners. 
 
Microsoft is a registered trademark; Windows is a trademark of Microsoft Corporation. 
 
 

Arizona Instrument LLC 
Jerome 651 Operation Manual 
Part Number 700-0093-J 
November 2008 
 
 
If you have any questions regarding the operation of this instrument, please call our toll 
free number from the USA and Canada (800) 528-7411 or e-mail at support@azic.com.  
Internationally, call (602) 470-1414 or fax (480) 804-0656. 
 




